# Table of Contents

Overview of Office 365 Email .................................................................................................................................................. 4

Accessing Outlook on the Web for Office 365 ......................................................................................................................... 5

Campus Email on Your Mobile Device .................................................................................................................................. 19

Setting Up Outlook with Your Office 365 Email on Your iOS Device .................................................................................. 20
Setting Up Mail with Your Office 365 Email on Your iOS Device .......................................................................................... 26
Setting Up Outlook with Your Office 365 Email on Your Android Device ........................................................................... 33
Setting Up Gmail with Your Office 365 Email on Your Android Device .............................................................................. 37
Setting Up Email App with Your Office 365 Email on Your Android Device ....................................................................... 47
Using Mobile Devices with Office 365 Email .......................................................................................................................... 55

Using and Maintaining Your Campus Email ............................................................................................................................. 56

Reviewing Mobile Devices Connected to Your Email Account ................................................................................................ 57

Email Account Sharing and Delegation .................................................................................................................................... 64

Add an Additional Mailbox in Outlook, as a Delegate .............................................................................................................. 65
Grant Access & Customize Permissions to your Campus Mailbox and Folders to a Delegate .................................................. 75
Email... On Behalf Of... an Outlook Account you are a Delegate For ...................................................................................... 80
Grant Delegation Access to Your Campus Outlook Account on a PC ....................................................................................... 86

Campus Email at Home for Faculty & Staff .............................................................................................................................. 93

Office 365 Email Setup on PC .................................................................................................................................................... 94
Office 365 Email Setup on Mac ............................................................................................................................................... 109
Office 365 Email Setup on iOS ............................................................................................................................................... 128

Email Contacts ............................................................................................................................................................................. 140

Search for a Contact in Outlook Address List .......................................................................................................................... 141

Proofpoint Email Protection ....................................................................................................................................................... 159

What is Proofpoint and What Does It Do? ............................................................................................................................... 160
How Do I Modify My Proofpoint Settings? ............................................................................................................................... 163
Proofpoint Overview Video ....................................................................................................................................................... 169

Campus Distribution Lists (DLs) .............................................................................................................................................. 170
What's the Difference Between a Campus Distribution List and a Distribution List? .......... 171
Sending an Email to a Campus Distribution List ................................................................. 173
Using an iPad to Send an Email to a Campus Distribution List ........................................ 178
Sending an Email to a Distribution List ........................................................................ 185
Managing Members of Your Distribution List ..................................................................... 188
Managing Your Distribution List ....................................................................................... 203
Troubleshooting Sending to a Distribution Lists ............................................................... 224
Campus Distribution List Resources ................................................................................. 226
Requesting a Distribution List ............................................................................................ 230
Clearing saved Distribution Lists ....................................................................................... 232
How to Clear the Cached Email Address from your Email Address Bar ............................. 236
Find the Owner(s) of a Distribution List ........................................................................... 243
Search Email (Outlook) ....................................................................................................... 254
Search Outlook Items (Email) in Outlook 2013 on a PC ..................................................... 255
Search Outlook Items (Online Archive) in Outlook Web Access (OWA) ............................ 259
Contact Help & Resources to Search and Maintain Campus Email .................................. 261
Exchange Archiving (Outlook) ............................................................................................ 262
Access Online Archive Email from a PC or Mac ................................................................. 263
Access Online Archive Email from a Web Browser ............................................................ 266
Contact Help & Resources for Email and Online Archive ................................................ 269
Delete Email from Campus Mailbox (including Online Archive & PST/Local Data File Folders) .... 273
Delete Individual Messages ................................................................................................. 274
Delete Multiple Messages ................................................................................................. 276
Overview of Office 365 Email
Accessing Outlook on the Web for Office 365

This article covers how faculty and staff can access their campus email on the web after being upgraded to Office 365 email.

Choose the way you want to access Outlook on the Web to see instructions on how to use that method.

Access using your portal

1. Log in to your campus portal.

View instructions on how to access your campus portal.

2. Click on the Faculty/Staff email icon.

1. Click on the Faculty/Staff email icon at the top right of the portal homepage.
2. Note that the Student email icon may appear if you have student access; you can hover over the button to check which email account each button will take you to.
3. Enter your campus username and password. Then click Sign In.

1. Enter your campus username and password.
2. Click Sign In.

4. You're done!
You're now logged in to Outlook on the Web. Continue reading for some tips on using Outlook on the Web.

Access using Login to Email page

1. **Open a web browser to the Login to Email page.**

Open a web browser to the [Login to Email page](#).

2. **Click on Email Login under Faculty/Staff Login.**

![Email Login](image-url)
3. Enter your campus username and password. Then click Sign In.

1. Enter your campus username and password.
2. Click Sign In.

4. You're done!
You're now logged in to Outlook on the Web. Continue reading for some tips on using Outlook on the Web.

Access using Microsoft's Outlook login page

1. Open a web browser to Microsoft's Outlook login page.

   ![Sign in to your account](https://outlook.office365.com/)

   Open a web browser to [Microsoft's Outlook login page](https://outlook.office365.com).

2. If you have used this link before, you may see your account listed already. Click on your account.

   ![Pick an account](https://outlook.office365.com)

   [Pick an account]
2.1. Enter your campus username and password. Then click Sign In.

1. Enter your campus username and password.
2. Click Sign In.

3. If you are on a different computer, you will be taken to a Microsoft login page. Enter your campus email address and then click Next.

1. Enter your campus email address (e.g. tstark@fullerton.edu).
2. Click Next.
3.1. Enter your campus username and password. Then click Sign In.

1. Enter your campus username and password.
2. Click **Sign In**.

4. You're done!

You're now logged in to Outlook on the Web. Continue reading for some tips on using Outlook on the Web.
Office 365 on the Web Tips

To make changes to your Outlook on the Web settings, click on the Gear icon at the top right of the screen.

If you want to modify settings for your Outlook on the Web, click on the gear icon at the top right of the screen.

NOTE: Some of the settings in Outlook on the Web (such as Manage add-ins) will affect your desktop Outlook settings as well.
You can find more settings for Outlook by scrolling down to My app settings and selecting Mail or Calendar or People.

Under the Settings menu, scroll down to the My app settings section to view more settings for your Mail, Calendar, and People (contacts).
Use the left menu to explore the settings that you can modify for Outlook.

Use the menu on the left to view and modify your settings.

NOTE: Most of the settings in Outlook on the Web (such as Automatic replies) will affect your desktop Outlook settings as well.
Remember when you make a change, click Save at the top of the page.

Click **Save** to save your changes. Or choose **Discard** to get rid of any changes you made.
To modify your picture or sign out of Outlook on the Web, click on the picture at the top right of the screen.

To modify your profile picture or sign out, click on the picture at the top right of the screen.

Click **Change** to modify your profile picture.

Click **About me** to modify your profile information on Microsoft Delve.

Click **Sign out** to sign out of Outlook on the Web.

*NOTE: Some of the settings in Outlook on the Web (such as your profile picture) will affect your desktop Outlook settings as well.*
To go to another Office 365 application like Word Online, OneDrive, or OneNote, click on the app launcher icon and select the app.

If you would like to switch to another Office 365 application, click on the app launcher icon at the top left of the screen and then select the application you want to open.

Notice that you have the option to open applications like Word and Excel. Keep in mind these are the online versions of these apps; clicking on Word will open Word Online and not Word on your desktop.

NOTE: If you accidentally choose one of these options and want to go back to Outlook on the Web, click on the grid icon and then select Mail.
Need More Help?

You can access Outlook on the Web Help by clicking on the question mark at the top right of the screen.

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777.
Campus Email on Your Mobile Device
Setting Up Outlook with Your Office 365 Email on Your iOS Device

This article covers how faculty/staff can set up the Outlook app on their Apple iOS device (e.g. iPad, iPhone) with their campus Office 365 email.

1. Tap on the Outlook app.

NOTE: When searching for this app on the Apple App Store, search for "Microsoft Outlook."
2. Tap Get Started.
3. Enter your campus email account and then tap Add Account.

1. Enter your campus email address (e.g. keverdeen@fullerton.edu).
2. Tap Add Account.
4. Slide the button next to Use Advanced Settings.

Turn on Advanced Settings by sliding the button next to **Use Advanced Settings**.
5. Enter your campus email address and password. Then enter outlook.office365.com as the server and your username @ad.fullerton.edu as the username. Then click Sign In.

1. Enter your campus email address (e.g. tstark@fullerton.edu).
2. Enter your campus password.
3. Optional: enter a description for this account.
4. Enter outlook.office365.com as the server name.
5. Enter your username as username@ad.fullerton.edu (e.g. tstark@ad.fullerton.edu).
6. Tap Sign In.
6. You're done!

Once you start seeing your emails appear in the Outlook app, you're all done!

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777.

Created by LAC
Setting Up Mail with Your Office 365 Email on Your iOS Device

This article covers how faculty/staff can set up the Mail app on their Apple iOS device (e.g. iPad, iPhone) with their campus Office 365 email.

1. Tap on Settings.
2. Tap Mail. Then tap Add Account.

1. Tap Mail.
2. Tap Accounts.

💡 If your device is on iOS 9 or below, the setting is Mail, Contacts, and Calendars.
3. Tap Add Account.
4. Tap Exchange.

5. Enter your campus email address and password. Then tap Next.

1. Enter your campus email address as username@fullerton.edu (e.g. tstark@fullerton.edu). Then type your current campus password.
2. Type a description for the account (optional).
3. Tap **Next**.

**6. Enter the server as outlook.office365.com and your username as username@ad.fullerton.edu. Then tap Next.**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td><a href="mailto:larthur@fullerton.edu">larthur@fullerton.edu</a></td>
</tr>
<tr>
<td>Server</td>
<td>outlook.office365.com</td>
</tr>
<tr>
<td>Domain</td>
<td>Optional</td>
</tr>
<tr>
<td>Username</td>
<td><a href="mailto:larthur@ad.fullerton.edu">larthur@ad.fullerton.edu</a></td>
</tr>
<tr>
<td>Password</td>
<td>XX</td>
</tr>
<tr>
<td>Description</td>
<td>Work Email</td>
</tr>
</tbody>
</table>

1. Enter **outlook.office365.com** as the server name.
2. Enter your username as **username@ad.fullerton.edu** (e.g. tstark@ad.fullerton.edu). Then type in your current campus password.
3. Tap **Next**.

*NOTE: Leave the Domain field blank.*
7. Select the types of account information you want to sync on this device. Then tap Save.

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Exchange</th>
<th>Save</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mail</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Contacts</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Calendars</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reminders</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Notes</td>
<td></td>
</tr>
</tbody>
</table>

Set the slider to green next to each account item you want to be able to view on this device. Then tap Save.
8. You're done!

Once you start seeing your emails appear in the Mail app, you're all done!

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777.
Setting Up Outlook with Your Office 365 Email on Your Android Device

This article covers how faculty/staff can set up the Outlook app on their Android device with their campus Office 365 email.

1. Tap on the Outlook app.
2. Tap Get Started.

3. Enter your campus email account and then tap Continue.

1. Enter your campus email address (e.g. keverdeen@fullerton.edu).
2. Tap Continue.

4. Enter your campus username and password. Then tap Sign.
5. You're done!

Once you start seeing your emails appear in the Outlook app, you're all done!
Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777.
Setting Up Gmail with Your Office 365 Email on Your Android Device

This article covers how faculty/staff can set up the Gmail app on their Android device with their campus Office 365 email.

1. Tap on the Gmail app.
2. Tap Add another email address.

![Image of Add another email address button](image)

**NOTE:** If you do not have any other accounts set up, you may need to tap Add Account.

3. Tap Exchange.

![Image of Exchange option](image)
4. Enter your campus email address. Then tap Manual Setup.

1. Enter your campus email address (e.g. keverdeen@fullerton.edu).

5. Tap Exchange.
6. Enter your campus password. Then tap Next.

1. Enter your campus password.
2. Tap **Next**.
7. Enter your username@ad.fullerton.edu and your campus password. Then enter outlook.office365.com as the server. Then tap Next.

1. Enter your username as **username@ad.fullerton.edu** (e.g. tstark@ad.fullerton.edu).
2. Enter your campus password (this may already be populated for you).
3. Enter **outlook.office365.com** as the server name.
4. Tap **Next**.

8. Tap OK when asked about enabling security features.
NOTE: You must allow these security settings to be updated in order to use your campus email on your device.

9. Select your account options and then tap Next.

Select your account options and then tap **Next**.
10. View the requirements and then tap Activate.
11. Modify your account name (if desired) and then tap Next.

You may modify your account name if you wish. Then tap **Next**.
11.1. Click Take Me to Gmail if you see this screen.

12. You're done!
Once you start seeing your emails appear in the Gmail app, you're all done!

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777.
Setting Up Email App with Your Office 365 Email on Your Android Device

This article covers how faculty/staff can set up the Email app on their Android device with their campus Office 365 email.

**NOTE:** These screenshots were taken on a Samsung Galaxy Pro Tablet so these steps may look different on your device. Please consult your device manufacturer's instructions/user guide for additional assistance.

**PLEASE NOTE:** The latest Android OS does not include an Email app; users should set up either [Outlook](https://outlook.com) or [Gmail](https://gmail.com) if using a newer device or OS.
1. Tap Settings.

2. Tap General and then tap Accounts. Then tap Add account.

1. Tap General.
2. Tap **Accounts**.
3. Then tap **Add account**.

**NOTE:** Your device may store information on the accounts tied to your device somewhere else but it should be within the Settings menu.

3. Tap **Microsoft Exchange ActiveSync**.

4. Enter your campus email address and password. Then tap **Manual setup**.
1. Enter your campus email address (e.g. keverdeen@fullerton.edu) and password.

5. Enter the Domain/username as username@ad.fullerton.edu. Then enter outlook.office365.com as the Exchange server. Then tap the right arrow.

1. Enter the Domain/username as username@ad.fullerton.edu (e.g. tstark@ad.fullerton.edu).
2. Enter your campus password (this may already be populated for you).
3. Enter outlook.office365.com as the Exchange server name.
4. Tap the right arrow at the top right of the screen to continue.
6. Tap OK.

![Activation screen](image)

7. Select your account options and then tap the right arrow.

![Account options](image)

Select your account options and then tap the right arrow at the top right of the screen to continue.
8. Modify your account name (if desired) and then tap Done.

9. Tap OK when prompted about updating security settings.

NOTE: You must allow these security settings to be updated in order to use your campus email on your device.
10. View the requirements and then tap Activate.

Once you start seeing your emails appear in the Email app, you're all done!
Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777.
Using Mobile Devices with Office 365 Email

This article consolidates all of the information on using Office 365 Email on mobile devices for faculty and staff.

Apple iOS Devices

I want to add my campus email to my Apple device for the first time

Choose the instructions for the email app (Outlook or Mail) that you want to set up on your Apple device:

Setting Up Outlook with Your Office 365 Email on Your iOS Device
Setting Up Mail with Your Office 365 Email on Your iOS Device

Android Devices

I want to add my campus email to my Android device for the first time

Choose the instructions for the email app (Outlook or Gmail) that you want to set up on your Android device:

Setting Up Outlook with Your Office 365 Email on Your Android Device
Setting Up Gmail with Your Office 365 Email on Your Android Device
Setting Up Email App with Your Office 365 Email on Your Android Device

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777.

Created by LAC
Using and Maintaining Your Campus Email
Reviewing Mobile Devices Connected to Your Email Account

This article covers how to review the mobile devices that are synchronized with your campus mailbox.

⚠️ **WARNING:** You will only be able to see devices connected with services such as Exchange ActiveSync. Devices using POP or IMAP will not show up in the mobile device window. Most newer devices use Exchange ActiveSync.

1. Log into Outlook on the Web.

View instructions on logging in to Outlook on the web.
2. Click on the gear, then under Your app setting, then click Mail.

1. Once in your email on the web, click the settings gear.
2. Then under **Your app setting**, click **Mail**.
3. Expand the General tab, then click Mobile devices.

1. Click and expand the General tab.
2. Then click on Mobile devices.
4. Review the devices that are connected to your email account.

Notice the devices listed. If you no longer have a device, feel free to remove it from your list.

Expand a device label to learn more about it.
1. Details icon

Click the **Details** icon to find out details about a connected device. Depending on the device, you may be able to see the device type, OS information, date first synced, and last sync time.

2. Remove icon

Click the **Remove** icon to remove the selected device from your campus email account you no longer have. This can also sometimes resolve email issues you may be having with a device.

**REMEMBER:** You have a limited number of devices you can sync to your account (10), so it is highly recommended that you remove any devices from your account you no longer have or log into your campus email account with.

**If you accidentally remove a device don't worry. When you access your email on this device again, it will be re-added to your list of devices.**

3. Wipe All Data icon

Click the **Wipe all data** icon to remotely wipe all data from the selected device.
CAUTION: This is only recommended if your device has been lost/stolen.

4. Start Logging icon

Click the **Start Logging** icon to request a log that shows the interaction between Exchange and your device, if the device synchronizes with Microsoft Exchange.

*This option will not appear if the device is not capable of providing a log.*

Example: With Logging option

![Example Logging Option](image)
Example: Without Logging option

5. Refresh icon...

Click the **Refresh** icon to refresh the mobile devices on the page.

**Need More Help?**

Contact the IT Help Desk at [helpdesk@fullerton.edu](mailto:helpdesk@fullerton.edu) or 657-278-7777 for additional assistance.
Email Account Sharing and Delegation
Add an Additional Mailbox in Outlook, as a Delegate

This article covers how to add an additional mailbox to a primary mailbox account in your Outlook desktop application, after being granted delegate access by a mailbox owner. The shared folder(s) will appear in your mailbox folder list.

⚠️ **Remember:** you must be granted permission by the mailbox owner to view their mailbox content through Folder Sharing or Delegate Access.

As a delegate, you are given rights to access shared data by the mailbox owner without the use of a password.

Access your mailbox account.

1. In your email, click the File tab.
2. In the Info section, select Account Settings.

1. Click the Account Settings drop-down.
2. Click Account Settings....
3. Select the email account that has been given delegate access, then click Change...
Add the additional mailbox.

4. In the Change Account window, click More Settings...

![Image of Change Account window with More Settings button highlighted]

**NOTE:** Ensure the Offline Settings box is checked for **Use Cached Exchange Mode**.
5. In the Microsoft Exchange window, click the Advanced tab to add any additional mailboxes.

1. Select the **Advanced** tab.
2. Click **Add...** From the Outlook directory, type the name of the mailbox you (the delegate) have been given permission to manage.
3. Click **Apply** > then click **OK**.
6. Click Next.
7. Congratulations!!! The mailbox has been added, click Finish.
8. Close Account Settings window, click Close.
9. Click the account name in your list of mailboxes to access the mailbox you have been granted access to.

Remember: A delegate will only have permission to access the folders they are granted access to.

⚠️ If you can’t expand the mailbox, you haven’t be granted the correct permissions by the mailbox owner. Contact the mailbox owner.
Need More Help?

Contact the IT HelpDesk at helpdesk@fullerton.edu or 657-278-7777.
Grant Access & Customize Permissions to your Campus Mailbox and Folders to a Delegate

This article covers how to give a delegate access to your (the manager) campus mailbox and folders. When a delegate needs regular access to the manager's mailbox and would like the mailbox to appear in their mailbox folder list, you (the manager) must grant the delegate account access to your (the manager's) mailbox by setting permissions. The delegate will only see the folders and features you (the manager) grants access to in Delegate Settings.

**NOTE:** You (the manager) must use a desktop version of Microsoft Outlook in order to add or remove delegates.

Grant Permission to Exchange Mailbox

1. In the folder list find the root folder.

   ![Image of Outlook folder list]

   1. Right-click on exchange mailbox (i.e. dhamblin@fullerton.edu).

   ![Image of right-click option]

   2. Select Folder Permissions.
2. Click **Folder Permissions**.

**NOTE**: The initial permission provided on the Inbox when **Granting Delegate Access to a campus Outlook Account** only allows the delegate to add the manager's account to the delegate's account. This does not allow viewing of any of the manager folders. To allow the delegate to have access to the manager's shared folders (Inbox or other shared folders), permissions must be set at the root folder on the exchange mailbox (i.e. dhamblin@fullerton.edu). Subfolders are only shared if permissions are set with the delegate.

2. Set Permissions.

![Permission Settings Diagram]

1. Select the **Permissions** tab.
2. Select the delegate.
3. In the **Permission Level** drop-down menu, select the permissions for your delegate (i.e. **Reviewer**). Remember permissions set when a delegate is added during **Granting Delegation Access for a campus Outlook Account**, only allows the delegate to add the manager's account to the delegate's account. This does not allow viewing of any of the manager folders. To set the permissions on the folders that are shared, Click the drop-down > Select **Permission Level**.

**NOTE**: Select the default Permission Level you want your delegate to have on your items in your folder or subfolders. If the default permission settings do not fit your need,
customize the permissions by selecting the appropriate check boxes and options under Permissions. Review default Permission Levels here.

2.1. Customize Permission Level.

1. Add a check-box to Create Items.
2. The permission level for this user is changed to Custom.
3. Click Apply then OK.

Now you can let your delegate know they can access the email folders that have been shared with them.

Grant Permission to Email Folder
3. In the folder list find the folder to share.

1. Right-click on the folder you want to share
2. Click Properties....
4. Add Delegate.

1. Select the Permissions tab.
2. Select the delegate. Click Add > Locate the delegate from Outlook Address Book > Click on the name to highlight it > Click Add > Click OK.
3. In the Permission Level drop-down menu, select the permissions for your delegate (i.e. Reviewer).
4. Click Apply then OK.

Now you can let your delegate know they can access the email folders that have been shared with them.

Need More Help?

- Grant Delegation Access to Your Campus Outlook Account on a PC
- Contact Help & Resources for Outlook Calendar & Email Sharing & Delegation

Created by: DBH
Email... On Behalf Of... an Outlook Account you are a Delegate For

This article covers how to create and reply to an email On Behalf Of... another Outlook campus exchange account after being granted delegate access to manage another Outlook campus mailbox (or calendar). The article also covers how to add the From button in to your email and how to add other managed accounts into a delegates account to send email on behalf of....

Create an... On Behalf Of... Email

1. In your email, click the Home tab.

Click New Email.
2. Select From to send email On Behalf Of...

- If there is No From button, continue to Add From Button
- If there is a From button, continue to Add On Behalf Of... Account

Add From Button

3. No From button, create a From field.

Click Options tab > in Show Fields group > Click From.

Add On Behalf Of... Account Name
4. Type the name From you can to send email... On Behalf Of...

1. Click the From drop-down. Accounts listed here are your primary and secondary email accounts. You can add any exchange accounts you have been granted delegation rights to send email on behalf of... here.

2. Click Other E-mail Address....

**NOTE:** If the exchange account you have been granted delegation rights to is listed in From, select the account and go to Construct the email to continue.

5. Type the account you are sending messages On Behalf of....

Type the manager account, the account that granted you access to send messages on their behalf. > Click ENTER on your keyboard.

Click OK.
6. Construct the email.

1. Add the **To** recipient(s), type the subject and the content to the message you're sending the email **on behalf of**....
2. Click **Send**.

**Email Recipient Receives.**

```
Thu 2/11/2016 10:24 AM
Lane, Lana on behalf of Hamblin, DeLana
Test***Change your password.
```

The recipient will receive an email from the delegate. The email is sent from the delegate **on behalf of** the manager: (i.e. *Lane, Lana on behalf of Hamblin, DeLana*).

**Reply to an... On Behalf Of... Email**
7. In the manager's mailbox, select the email.

Select the email you want to reply on behalf of....

8. Click Reply, Reply All or Forward.

9. Fill out the Reply email.

1. The From will automatically populate with the account you are managing so that you can Reply on behalf of... that manager's account. If you want to reply on
behalf of... another account you are a delegate for, select the drop-down arrow on the **From** button to change the name you can send **on behalf of**... To add an Outlook account you are a delegate of so you can send email **on behalf of**..., view **Add On Behalf Of... Account Name**.

2. Add the **To** recipient(s), type the subject and the content to the message you're sending the email **on behalf of**....

3. Click **Send**.

**Email Sent... On Behalf Of...**

![Email Sent](image)

Email that is created and sent from the delegate's email **on behalf of**... a managed account can be found in the delegates **Sent Items** folder.

**Need More Help?**

- [Manage a Shared (Delegate) Outlook Email Account](#)

**Contact Help & Resources for Outlook Calendar & Email Sharing & Delegation**

Created: DBH
Grant Delegation Access to Your Campus Outlook Account on a PC

This article covers how to set up a delegate for your (the manager) campus Outlook account. Delegates are mainly used to maintain the manager's calendar (i.e. schedule and accept meetings on your behalf) but the manager can also allow delegates to view their email, tasks, and contacts.

**NOTE:** You (the manager) must use a desktop version of Microsoft Outlook in order to add or remove delegates.

Access Account Settings

1. In Microsoft Outlook, select the File option.

1. Select the **Info** section.
2. Select **Account Settings**.
3. Select **Delegate Access**.

**Add Delegate Account**
3. Click Add.
4. Find the delegate, click Add, and then click OK.

1. Locate the delegate from Outlook Address Book > Click on the name to highlight it.
2. Click Add.
3. Then click OK.

Assign Permissions
5. Specify the permissions for the delegate.

1. Choose the permissions you want this specific delegate to have in each area.
2. Click **OK**.

- **None**: delegate cannot access this feature of your account
- **Reviewer**: delegate can read items
- **Author**: delegate can read and add items
- **Editor**: delegate can read, modify and add item

**NOTE**: An easy way to notify this delegate of their permissions is to check the box to automatically send an email to them summarizing their permissions.
6. Choose your meeting request/response options and then click OK.

1. Specify how you (the manager) wants your meeting requests and responses to be handled (NOTE: this applies to ALL of your delegates).
2. Click OK.

Did you (the manager) share your Email?

In reference to email, the permissions set above only gives a delegate access to add an account to a manager's mailbox. The delegate will not be able to see any of the manager’s mail folders, including the Inbox. In order for the delegate to view the manager's Inbox and other folders that have been shared, view the instructions: Grant Access to your Campus Mailbox and Folders to a Delegate.

To help your delegate setup their Outlook to manage your email account, have them view: Manage a Shared (Delegate) Outlook Email Account on a PC.
Did you share your Calendar?

View instructions to continue sharing your calendar.

Need More Help?

Contact Help & Resources for Outlook Calendar & Email Sharing & Delegation

Created by: DBH
Campus Email at Home for Faculty & Staff
Office 365 Email Setup on PC

This article will walk you through the steps to set up Outlook on your home computer. You will need to download Office 365 Pro Plus, which, depending your Internet connection speed can take up to an hour. If you already have Office 365 Pro Plus and configured to retrieve your CSUF email and are having issues, you can remove the settings and follow these instructions.

Install Office 2016

⚠ Prior to going through this installation of Office, you must remove any previous version of Office currently installed on your PC.
1. Go to www.office.com using the web browser of your choice. Click “Sign in” either on the top-right of your screen or in the middle.
2. Enter your email address under "Sign in"
3. Microsoft will detect your CSUF email address and redirect you to the Microsoft Office Faculty/Staff Sign In. Enter your user name and password and click “Sign In”

4. Choose whether or not you would like to stay signed in by clicking "No" or "Yes"

⚠️ If you are doing this on a shared computer we recommend you click on "No" otherwise, if this is your personal computer you can click "Yes" just be aware that when you change your password you will need to enter the new password when signing in
5. Near the top-right of your screen, click "Install Office apps" and click "Office 2016" from the drop-down menu that appears

6. The setup file will be downloaded and a pop-up from Microsoft will appear with instructions on how to run the setup file

⚠️ Note that these instructions may vary based on the web browser that you are using. For this documentation, Google Chrome is being used
Just a few more steps...

1. Click Run
   Click the Setup file at the bottom of the screen.

2. Say "Yes"
   Click Yes to start installing.

3. Stay online
   After the installation, start Office and sign in with the account that you use for Office 365: brooth@FULLERTON.EDU.

Close

Need any help with the installation?
7. Once you have run the file, Office will begin its installation. This may take several minutes.
8. Once it has finished, close all windows currently open

Configure Outlook 2016

1. Click the Windows “Start” button at the bottom-left of your screen and look for Outlook 2016

⚠️ This step may look different than the picture below depending on what version of Windows you have. This documentation was created using Windows 10 Version 1703.15063.909
2. Click "Accept" to agree to the Microsoft Office License Agreement
3. Enter your CSUF email address and click "Connect"

⚠️ the email should be in this format: username@fullerton.edu

4. The Microsoft Office Faculty/Staff sign in page will pop up. Enter your user name and password and click "Sign In"
5. Click "Yes" to add this account to Windows for easier sign ins. Otherwise, click "Skip for now"
6. Wait for your device to be registered and policy to be applied
7. Click "Done"

8. Un-check the box to "Set up Outlook Mobile on my phone, too" and click OK
9. You're all done. It may take a few minutes for Outlook to download your emails

Need additional help?

Contact the CSUF IT helpdesk at (657)278-7777 or helpdesk@fullerton.edu
Office 365 Email Setup on Mac

This article will walk you through the steps to set up Outlook on your home computer. You will need to download Office 365 Pro Plus for Mac, which, depending your Internet connection speed can take up to an hour. If you already have Office 365 Pro Plus for Mac and configured to retrieve your CSUF email and are having issues, you can remove the settings and follow these instructions.

Install Office 2016 for Mac

Prior to going through this installation of Office, you must remove any previous version of Office currently installed on your Mac.

1. Go to the Office homepage using the web browser of your choice. Click “Sign in” either on the top-right of your screen or in the middle.

Open your browser to the Office homepage. Then click Sign in.
2. Enter your email address under "Sign in"

⚠️ the email should be in this format: username@fullerton.edu
3. Microsoft will detect your CSUF email address and redirect you to the Microsoft Office Faculty/Staff Sign In. Enter your user name and password and click “Sign In”

![Microsoft Office Faculty/Staff Sign In](image)

4. Choose whether or not you would like to stay signed in by clicking "No" or "Yes"

⚠️ If you are doing this on a shared computer we recommend you click on "No" otherwise, if this is your personal computer you can click "Yes" just be aware that when you change your password you will need to enter the new password when signing in
5. Near the top-right of your screen, click “Install Office apps” and click “Office 2016” from the drop-down menu that appears.
6. The setup file will be downloaded and a pop-up from Microsoft will appear with instructions on how to run the setup file.

⚠️ Note that these instructions may vary based on the web browser that you are using. For this documentation, Safari is being used.
7. You will be brought to the following screen once opening the .pkg file that was downloaded, click "Continue"
8. Click "Continue"
9. Click "Agree"

10. Click "Continue"

⚠️ Typical installation type is "Install for all users of this computer"
11. Click "Install"
12. Enter the user name and password that you use to log into your Mac

⚠️ The account must have administrative rights in order to install the software
13. Wait for the installation to finish. The installation’s “Install time remaining” may not be entirely accurate and it may take several minutes to complete despite what it says. Please be patient.
14. Click "Close"
Configure Outlook 2016 for Mac

1. Open "Finder" and navigate to your "Applications" folder and launch Microsoft Outlook
2. Click "Get Started"
3. Click "Start Using Outlook"
4. If Outlook finds your email account, click "Add username@ad.fullerton.edu" and your account will be set up automatically and you can skip to step 7.
5. If you are prompted to enter your email address, enter your email address (username@fullerton.edu) and click "Continue"
6. The Faculty/Staff Sign in window will pop up, enter your user name and password and click "Sign In"
7. Your account is now setup. Click "Done"

Need more help?

Contact the CSUF IT helpdesk at (657)278-7777 or helpdesk@fullerton.edu
Office 365 Email Setup on iOS

This article will walk you through the steps to set up your CSUF email on your iOS device. These instructions were made in iOS 11.2.6

1. From your Home Screen open "Settings"
2. Navigate to and click "Accounts & Passwords"
3. If you have previously set up your CSUF email on your device and you are trying to fix an issue, you will need to delete the account and remove it before you can add it back. Otherwise, proceed to step 4

3.1. Click your existing CSUF email (It is labeled "Exchange" by default)
3.2. Scroll to the bottom of the page and click "Delete Account"
3.3. Click "Delete From My iPhone/iPad"
4. Click "Add Account"
5. Click "Exchange"
6. Enter your email address in the "Email" field. Click on the empty description and it will automatically populate as "Exchange," click "Next"
7. A new pop-up will appear, click "Sign in"
8. You will be taken to the CSUF Faculty/Staff Sign in page. Enter your user name and password and click "Sign in"

⚠️ If this is the first time setting up your email on this device, another pop-up will appear. Click on "Allow"
9. By default, all five options will be enabled (Green). You can deselect the options (Gray) that you do not want synced to your account. You can edit these options later in Accounts & Password. Click "Save" when you are finished selecting which options will be synced.

10. You're all done

⚠️ It may take several minutes to fully synchronize as it is downloading your data from the Office 365 server.
11. Need additional help?

Contact the CSUF IT helpdesk at (657)278-7777 or helpdesk@fullerton.edu
Email Contacts
Search for a Contact in Outlook Address List

This article covers how to search for a contact or email address in the Outlook address book.

These instructions were created on a PC. AccessMac instructions are similar.

Search for a Contact from Your Computer

1. Begin your search...

1.1. within an email.

Follow these instructions when creating a new email or on an existing email.
Create a new email, then click "To..."

1.2. from the address book.

In the menu bar, click the "Address Book" icon.
2. Click the Address Book drop-down, then select Global Address List.

1. Click the drop-down for the address book.
2. Select the **Global Address List**.

*Selecting the **Global Address List** will ensure you are selecting contacts from the campus directory. Select **Contacts** listed under your mailbox account to see any contacts created in the personal contact list.*
3. In the search window, type the name of the contact.

As you type the contact name, the contact that best fits your entry will populate to the top of the address window. Double-click on the desired contact name.

💡 Under **Name Only** you will only be able to search for contact members by their last name or department name. To search by other fields in the contact, change the search option to **More columns** or use **Advanced Find**.
Search using More Columns and Advanced Find

3.1. Change the search option to More Columns...

1. Select **More columns** to search for a contacts by email address, first or last name, etc.
2. Type the contact name you want to search, then click **Go**.
3. Only the contacts that match the name typed will populate in the search result window. Double-click on the desired contact name.

💡 You will only be able to search fields identified in the contact address book. Look at **Advanced Find** to see the fields you can search.
3.2. Select Advanced Find...

3.2.1. Type the name or data you want to search in a field, then click OK.
1. Type the contact's information you want to search for in any of the advanced fields.
2. Click **OK**.

### 3.2.2. The list of contact(s) will populate based on the data typed in the field.

![Address Book Search Results - Global Address List](image)

1. Based on the data typed in the **Advanced Find** field, data is retrieved from the address book.
2. Select and double-click on the desired contact name you are looking for from the search window.

💡 **REMEMBER:** If you cannot find a contact in the address book, make sure you have included spaces, hyphens, etc. as they should appear in the name. You will need to type the name exactly as it appears in the address book in order for them to populate in the search result window.
4. If the contact was searched...

4.1. within an email, select the contact name to add it to your email.

Select to highlight the contact name.

Click **To ->** to populate the contact name in the email.

Click **OK.**
4.1.1. The contact name is populated into the email.
4.2. from the address book, you will be able to view the selected account's contact information

![Contact Information in Outlook](image)

Click OK to close the contact information.

**Search for a Contact using Outlook on the web.**

> These instructions can also be used if you are using a Mac computer.

1. Log into Outlook on the web.

[View the instructions on logging into Outlook on the Web](#)
2. Access the People icon...

from the email window.

1. Click the people icon.

Click the people icon located in the bottom left corner on the page.
2. Select "Directory".

Changing the default selection from **Featured people** to **Directory** will allow you to search the entire campus directory of accounts, not just your personal list of accounts and contacts.
from the menu bar.

1. Click the grid square in the top left corner.
2. Click "All Apps".

3. Search for the people icon.

1. Type *people* in the search window.
2. Click the *People* icon.
4. This will open to Directory, allowing you to search all campus accounts.
3. In the Search Directory window type the contact name.

1. Type the name in the search window you are looking for.
2. Select the name when it populates in the pop-up window.

Click the magnifying glass or hit Enter on a PC, (Return on a Mac) to be directed to the Search results window, then click the name in the search results window.
4. Click on an contact to display their contact information.
Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Proofpoint Email Protection
What is Proofpoint and What Does It Do?

This article is an overview of the Proofpoint email protection system which is used for all faculty/staff email accounts on campus.

Proofpoint Overview

Proofpoint is an email protection system that blocks spam, phishing, and viruses from reaching your inbox. In addition you can customize your settings to block and un-block specific emails.

Proofpoint will send you an email (as shown in the image below) when it blocks an email to give you the option of releasing messages and/or senders that you do not consider to be spam.

Safe URLs

Proofpoint will also locate URLs in your emails and add a prefix that will allow Proofpoint to check the URL before it opens it in your web browser. You won't notice a delay in opening the URL; Proofpoint takes only milliseconds to analyze the URL before allowing you to the site.
If Proofpoint deems a URL to be unsafe to access, you will see a message similar to the image below.

![Web Site Has Been Blocked!](image)

**What Do I Need To Do?**

You may want to glance at the Proofpoint emails when you receive them to make sure that Proofpoint isn't accidentally blocking an email or sender that you recognize.

Some things that you can do with Proofpoint:

---

Email // Downloaded: 06-15-2019 // Disclaimer: This document is only valid as of the day/time when it is downloaded. Please view the original web document for the current version.
• Release a specific email from Proofpoint's quarantine
• Add a sender to the safe sender list for your account
• Mark an email as not spam
• Send yourself a new digest email that lists all of the emails currently in quarantine
• Send yourself an email with all of the safe and blocked senders that you have added for your account

View the article on how to manage your Proofpoint settings to find out more.

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
How Do I Modify My Proofpoint Settings?

This article covers how to modify your Proofpoint settings including releasing a specific email, adding a sender to your safe (or blocked) sender list, marking an email as not spam, sending yourself a new digest email that lists all of the emails currently in your quarantine, and sending yourself an email with all of the safe and blocked senders on your list.

Actions You Can Take With Quarantined Email

The messages in your personal Digest represent emails that have been filtered and sorted into different categories, giving you an opportunity to take action on them. Click the link in the Subject column to view the message.

Click on an action to remove the email from the spam quarantine. If you do nothing, the email will be deleted after 30 days.

What does each action mean?

- **Release**: allows this one specific message to go to your inbox.
- **Release and Allow Sender**: allows this one specific message to go to your inbox and adds the user to your "safe sender" list so you will receive all future emails from the sender.
- **Not Spam**: allows this one specific message to go to your inbox and teaches Proofpoint to allow emails with similar content to reach your inbox (e.g. if you are
on a email newsletter list and you mark one email newsletter as Not Spam, Proofpoint should allow all future editions of that email newsletter even if the newsletter is sent from different email addresses).

**Requesting a New End User Digest**

Click **Request New End User Digest** to receive an updated email from Proofpoint with all of the emails that are currently in your spam quarantine folder.

This may be useful if you have just released a message or if you simply want an updated list of the emails in quarantine.
Requesting Safe/Blocked Senders List

Click Request Safe/Blocked Senders List to receive an email with a list of all of the email addresses that you have added as a "safe sender" or a "blocked sender."

This allows you to review the email addresses that you have added as safe and blocked and make any changes as needed.

You will only see email addresses that you have added as safe or blocked using Proofpoint; for example you will not see any emails that you have marked as "junk" in Microsoft Outlook.
Managing Your Proofpoint Account

Click **Manage My Account** to go to the Proofpoint web application.

In the Proofpoint web application you can:

- review the emails that are currently in your spam quarantine folder
- delete emails that are currently in your spam quarantine folder
- release emails in your spam quarantine folder
- mark emails in your spam quarantine folder as "not spam"
- add users to your safe or blocked sender lists
- request a new end user digest email
- request an email with your safe/blocked senders list
1. Click **Quarantine** to view all of the messages that are currently in your quarantine (i.e. are marked as spam).

2. You can search these emails, release selected emails, mark selected emails as not spam, allow the sender of selected emails, or use the Options menu to request a new end user digest email.
Lists

1. Click **Lists** to access your Safe Senders List and Blocked Senders List.
2. In the Lists folder, you will see your safe senders list and your blocked senders list.
3. For each list, you can add, edit, and delete email addresses. You can also use the Options menu to request the lists to be emailed to you.

**Need more Help?**

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Proofpoint Overview Video

This article contains a video overview of the Proofpoint system including what it is, how it works, and how to manage your settings.

Click the play button to start the video and then use the video controls at the bottom of the video to interact with the video.

Having trouble viewing the video above or want to view it in a new window/tab?

View ProofPoint Overview Video in Full Screen/New Window

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Campus Distribution Lists (DLs)
What's the Difference Between a Campus Distribution List and a Distribution List?

This article covers the way distribution lists are set up at CSUF as well as the differences between campus distribution lists, distribution lists, and contact groups.

What is a Campus Distribution List?

The Campus Distribution Lists are:

- DL-Campus Employees
- DL-All-Faculty
- DL-All-Staff
- DL-Full-Time Faculty
- DL-Part-Time Faculty
- DL-Full-Time Staff
- DL-Part-Time Staff
- DL-Management

The membership of and access to send to these campus distribution lists are managed by the Information Technology division.

For more help:

View the article on Campus DL Access Request to find out how to get access to send to the campus distribution lists.

View the article on sending emails to Campus DLs

View the article on sending emails to Campus DLs using an iPad

What is a Distribution List?

All other distribution lists are ones created by the Information Technology division that appear in the Global Address Book in Microsoft Outlook.
Typically the membership of and access to send to these distribution lists are managed by the owner of the distribution list. You can view the owner by opening the distribution list's entry in the Global Address Book. Contact the owner for information about being added to the distribution list or getting access to send to the distribution list.

For more help:

View the article on sending to a distribution list

View the article on managing members of a distribution list

What are contact groups?

Contact groups are like personal distribution lists that only exist in your personal email account. You find them under your People/Contacts folder in Microsoft Outlook. These differ from distribution lists in that YOU are the only person who can send emails to the contact group.

For more help:

View this Microsoft support article on creating contact groups

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Sending an Email to a Campus Distribution List

This article covers how authorized users can send an email to one of the campus distribution lists.

The Campus Distribution Lists are:

- DL-Campus Employees
- DL-All-Faculty
- DL-All-Staff
- DL-Full-Time Faculty
- DL-Part-Time Faculty
- DL-Full-Time Staff
- DL-Part-Time Staff
- DL-Management

⚠️ Remember that you must use an administrative account (e.g. ittraining@fullerton.edu) rather than your personal work account to send emails to these distribution lists. Be sure you know which administrative account(s) you have access to use to send emails to these distribution lists and which account is most appropriate for the email you want to send before you get started.
1. First, compose your email. All of the content should be reviewed and complete before addressing the email to any distribution list(s).

1. To avoid accidentally sending out the email message before you have completed it, leave the To, CC, and BCC fields blank until you have entered, reviewed, and completed all of the content including the subject, message body, signature, attachments, and accessibility requirements such as alt text for the images.

2. Be sure that the From field is set to the administrative account that you are going to use to send the email.

For more information on creating an appropriate and accessible email, view the Campus DL Online Training and the Campus DL Resources.
2. Click on the To field and enter the full name of the distribution list in the Global Address List search field.

1. Click on the To field in your email.
2. Enter the full name of the distribution list you want to send to in the search field.
3. Double click on the entry and then click OK.

1. Double click on the distribution list name to add it to the To field.
2. Click OK.
4. Review your email at least one more time for content and accessibility. Then click Send. You're done!

I get an error when trying to send to a campus distribution list!

View this article on troubleshooting sending to distribution lists.

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Using an iPad to Send an Email to a Campus Distribution List

This article covers how authorized users can send an email to one of the campus distribution lists using an iPad.

The Campus Distribution Lists are:

- DL-Campus Employees
- DL-All-Faculty
- DL-All-Staff
- DL-Full-Time Faculty
- DL-Part-Time Faculty
- DL-Full-Time Staff
- DL-Part-Time Staff
- DL-Management

💡 Remember that you must use an administrative account (e.g. ittraining@fullerton.edu) rather than your personal work account to send emails to these distribution lists. Be sure you know which administrative account(s) you have access to use to send emails to these distribution lists and which account is most appropriate for the email you want to send before you get started.

⚠️ You must have your administrative account added an account on your mobile device in order to follow these instructions. This usually means you need the username and password for the account.
When sending from an iPad, emails are typically in plain text format so you will not be able to add any formatting or images. You will be able to an attachment as long as you have access to it from your iPad (e.g. if it’s stored in Dropbox).

1. First, compose your email. All of the content should be reviewed and complete before addressing the email to any distribution list(s).

![Email Composition Example]

Be sure that the From field has been changed to your administrative account and you are not using your personal account.
I am using the Mail app

1. Tap the plus sign icon at the far right of the To field.

   ![Email interface](image)

   - To:
   - Cc/Bcc, From: itraining@fullerton.edu
   - Subject: Important Training Notification for Campus Users
   - Dear Campus Community,
   - This is a very important training notification that applies to all campus users.
   - Lori Arthur-Carmichael
   - IT Training @ CSU Fullerton
   - larthur@fullerton.edu // 657-278-5792

2. Tap Groups.

   ![Groups interface](image)

   - Dear Campus Community,
3. Scroll down to the Global Address List for your administrative account.

If you have both your administrative account and your personal work account on this device, be sure you select the Global Address List for your administrative account. This is because some accounts have been moved to Office 365 Email and accounts on Office 365 will send to a different entry for campus DLs.

4. Type the full name of the DL in the search field. Then tap on the appropriate listing for the distribution list(s) you are sending to.

1. Type the full name of the DL in the search field.
2. Then tap on the appropriate listing when it appears.
I am using the Microsoft Outlook app

1. Tap the To field.

2. Type the full name of the distribution list in the search field. Then tap Search Directory.

1. Type the full name of the distribution list.
2. Tap Search Directory.
3. Tap on the distribution list you want to send to.

2. Review your email at least one more time for content and accessibility. Then tap Send. You're done!

I get an error when trying to send to a campus distribution list!

View this article on troubleshooting sending to distribution lists.
Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Sending an Email to a Distribution List

This article covers how users can send emails to distribution lists in the campus Microsoft Outlook Global Address Book.

These instructions are for distribution lists created in the campus Global Address Book. If you create contact groups in your own email account in Outlook, you can find instructions on the Microsoft Support website.

1. Compose your email and review it for accuracy. Then click on the To field and enter the full name of the distribution list in the Global Address List search field.

1. Click on the To field in your email.
2. Enter the full name of the distribution list you want to send to in the search field.

2. Double click on the entry and then click OK.

1. Double click on the distribution list name to add it to the To field.
2. Click OK.
3. Review your email at least one more time for content and accessibility. Then click Send. You're done!

I get an error when trying to send to a distribution list!

View this article on troubleshooting sending to distribution lists.

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Managing Members of Your Distribution List

This article covers how users can manage the members of their distribution lists using Microsoft Outlook and Outlook on the Web.

These instructions are for distribution lists created in the campus Global Address Book. If you create contact groups in your own email account in Outlook, you can find instructions on the Microsoft Support website.

Modify your DL using Outlook (PC users only)

1. Open Microsoft Outlook and then open the Address Book.

Open up Microsoft Outlook and click on the Address Book button to open it.
2. Locate the distribution list by typing the full or partial name of it. Then double click on the DL to open it.

1. Check that you are using the **Global Address List** as the Address Book instead of the Offline Global Address List.
2. Type in the full or partial name of the distribution list you want to modify.
3. Double click on the DL in the list to open it.
3. Click Modify Members.

4. To add a person to the DL, click Add.
4.1. Type the name of the person you want to add. Then double click on the name to add it to the Add field. Repeat with any additional people you want to add. Then click OK.

1. Type in the name of the person you want to add.
2. Double click on the person's name in the list.
3. The person's name will appear in the Add section at the bottom of the window.
4. Once you have added all of the names that you wish to add to the DL, click OK.

💡 It is not recommended to add more than about 10 people to a DL at one time.
4.2. Click OK.

4.3. Click OK again to save your changes. You're done!
5. To remove a person from the DL, click on their name in the Members list and then click Remove.

1. Click on the name of the person you want to remove from the DL.
2. Then click Remove.

5.1. Then click OK.
Once you have finished removing the names you want taken off of the DL, click **OK**.

![Warning: It is not recommended that you remove more than 10 names from the DL at one time.]

5.2. **Click OK again to save your changes. You're done!**

Modify your DL using Outlook on the Web (PC and Mac users)

1. **Log in to Outlook on the Web.**

   [View instructions on logging into Outlook on the Web.](#)
2. Click the Settings icon.

Click on the Settings icon at the top right of Outlook on the Web.

3. Scroll down and select Mail under Your App Settings.
4. Click General.

5. Click Distribution groups.
6. Locate the DL you want to modify under Distribution groups I own and double click on it to open it.

7. Click membership.
8. To add a user to the distribution list, click the plus icon.
8.1. Type the name of the person you want to add and then click the magnifying glass to search. Then click the plus icon next to their name to add them to the Members field. Repeat with any additional people you want to add. Then click Save.

1. Type in the name of the person you want to add and then click the magnifying glass to search.
2. Click on the plus icon next to the user's name.
3. The person's name will appear in the Members section at the top of the window.
4. Once you have added all of the names that you wish to add to the DL, click **Save**.
8.2. Click Save to save your changes. You're done adding members!

![Members list with 'Save' and 'Cancel' buttons]
9. To remove a user from the distribution list, click on the name you want to remove. Then click the minus icon.

1. Click on the name of the person you want to remove from the DL.
2. Then click the minus icon.
9.1. Click Save to save your changes. You're done removing members!

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Managing Your Distribution List

This article covers how distribution list owners can manage their distribution list including: adding/removing owners, adding/removing members, changing who can send to the distribution list, and more.

1. Log in to Outlook on the Web to manage your distribution list.

   View article on accessing Outlook on the Web.

2. Click the Settings icon.

   Click on the Settings icon at the top right of Outlook on the Web.
3. Scroll down and select Mail under Your App Settings.
4. Click General.

5. Click Distribution groups.
6. Locate the distribution list you want to modify under Distribution groups I own and double click on it to open it.

Choose the action you want to take with your distribution list from the items below to view instructions.

Hiding the distribution list from the Outlook Address Book

Hiding your distribution list from the Outlook Address book changes your distribution list to "unlisted" and it will not appear in any searches of the address book.

⚠️ If your distribution list is hidden, you MUST type the full email address of the distribution list each time you want to send an email to it.
1. Place a checkmark next to Hide this group from the shared address book in the general section. Then click Save.

To change your distribution list from hidden to visible, simply uncheck the Hide this group from the shared address book.

Adding/Removing Owners

Adding or removing another owner will grant or revoke access to manage the distribution list which includes all of the actions in this article.
1. Click ownership.

2. To add an owner, click on the plus icon.
2.1. Type the name of the person you want to add and then click the magnifying glass to search. Then click the plus icon next to their name to add them to the Owners field. Repeat with any additional people you want to add. Then click Save.

1. Type in the name of the person you want to add and then click the magnifying glass to search.
2. Click on the plus icon next to the user's name.
3. The person's name will appear in the Owners section at the top of the window.
4. Once you have added all of the names that you wish to add as owners, click Save.
2.2. Click Save to save your changes. You're done adding owners!

3. To remove an owner, click on the name you want to remove. Then click the minus icon.

All groups must have at least one owner who's responsible for managing the group. By default, you're an owner of the group you're creating.
The Microsoft tip will remind you that you must have at least ONE owner of this distribution list.

1. Click on the name of the person you want to remove as an owner of this distribution list.
2. Then click the minus icon.

3.1. **Click Save to save your changes. You're done removing owners!**

Adding/Removing Members

You can add/remove members of your distribution list in both Outlook on the Web and in the desktop Microsoft Outlook application.

View article on managing members of your distribution list.
Allowing Users to Add or Remove Themselves as Members

Membership approval allows you to change whether users can add themselves to your distribution list. By default, all distribution lists have closed membership, meaning that an owner must add/remove members.

1. Click membership approval.
2. Choose the type of membership approval you want for this distribution list. Then click Save.

Choose the membership approval type you want for this distribution list.

- Open: anyone with a CSUF employee email account can join/leave this distribution list without approval.
- Closed: only owners can add or remove members to the distribution list.
- Owner approval: when a user requests to join a distribution list, the owner(s) will receive a notification and must approve the request.

Click **Save** after making your selection.

**Changing Who Can Send to Your Distribution List**

Use delivery management to allow only specific users to send to your distribution list or to allow all campus employees to send to it. By default, all employees on campus can send to your distribution list.
If you need to allow off-campus users to send to your distribution list, please contact the Help Desk at helpdesk@fullerton.edu.

1. Click delivery management.
2. To allow a user to send to the distribution list, click the plus icon.

By default, only senders inside your organization can send messages to this group. To allow someone outside your organization to send to the group, contact your email admin. To restrict the senders inside your organization who can send to the group, add users or groups to the list below. If you do this, mail sent by anyone else will be rejected.

All senders can send messages to this group.
2.1. Type the name of the person you want to add and then click the magnifying glass to search. Then click the plus icon next to their name to add them to the Allowed senders field. Repeat with any additional people you want to add. Then click Save.

1. Type in the name of the person you want to add and then click the magnifying glass to search.
2. Click on the plus icon next to the user's name.
3. The person's name will appear in the Allowed senders section at the top of the window.
4. Once you have added all of the names that you wish to add as allowed senders, click **Save**.
2.2. Click Save to save your changes. You're done adding allowed senders!
3. To remove an allowed sender's access to your distribution list, click on the name you want to remove. Then click the minus icon.

1. Click on the name of the person you want to remove.
2. Then click the minus icon.
3.1. Click Save to save your changes. You're done removing allowed senders!

![Image showing email options]

⚠️ Notice that if you remove all allowed senders, all campus employees will be allowed to send to the distribution list.

**Viewing Email Options**

Email Options will show you the email addresses associated with your distribution list.
1. Click email options.

2. Review the valid email addresses for your distribution list.

The group can receive messages sent to the following addresses.

- DL-IT-test@adcsuf.mail.onmicrosoft.com
- DL-IT-test@Exchange.FULLERTON.EDU
- DL-IT-test@Fullerton.edu
It is highly recommended that you use the @fullerton.edu email address when sending to a distribution list.

Changing MailTip

This MailTip will appear when users add your distribution list to the To field of an email. Creating a MailTip allows you to set up a customized message for users who are sending to your distribution list. This can be used to remind them of any relevant information about sending to your distribution list such as rules about appropriate content.

1. Click MailTip.
2. Type your content in the MailTip box. Then click Save.

1. Enter the information you want to appear in the MailTip. Note the Microsoft tip that indicates a maximum of 175 characters is allowed.
2. Click Save.

3. Users will now see the MailTip when they add your distribution list to the To field of an email.
Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Troubleshooting Sending to a Distribution Lists

This article covers troubleshooting tips when you are having problems sending to a Distribution List.

Problem Sending to a Distribution List:

You receive a bounce back email from a Distribution List

Solution 1: Clear the cached email address and try sending again.

1. View article on How to Clear the Cached Email Address from your Email Address Bar.
2. Try sending the email again.

Solution 2: Check that you have the proper permission to send to the distribution list.

Contact the distribution list owner to confirm that you are listed as an authorized sender.

If you need assistance finding the owner of a distribution list, view the article on finding the owner of a DL.

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
This article contains resources to assist users in crafting appropriate and accessible emails to be sent to the campus community.

Mainly these rules apply to emails sent to campus distribution lists such as DL-Campus Employees, but these are best practices for sending emails to any distribution list.

💡 Where noted, IT has provided resources for standard users (users who are sending typical email messages to campus) as well as for more advanced users who want to know more detail about accessibility and standards.

Campus Standards

**Standard User Resources**

**CSUF Brand Central**

- The official website for CSUF branding. Includes official typography and color standards as well as downloads of the university signature block and logo.

**Advanced User Resources**

**Website Standards & Guidelines**

- provides guidance on creating webpages, but includes many tips on using appropriate color contrast (including with university colors) and typography.
Accessibility Resources

Standard User Resources

**Microsoft Office: Add alternative text to a shape, picture, chart, table, SmartArt graphic, or other object**

- This article covers how to add alternative (alt) text to an image, shape, etc. in Microsoft Outlook, Word, Excel, and PowerPoint.

**Microsoft Office: Learn to create more accessible Word documents**

- This set of tutorials covers many accessibility features including finding and fixing issues, using alt text, using heading styles, and more!

**Accessible Technology Initiative (ATI)**

- CSU Fullerton's website on the Accessible Technology Initiative.

**Professional Development for Accessible Technology**

- The CSU's website on the Accessible Technology Initiative. Includes video tutorials and guides.

Advanced User Resources

**CSU Executive Order 926**

- This CSU executive order mandates CSU campuses to make its programs, services, and activities accessible to individuals with disabilities.

**Section 508 of the Rehabilitation Act of 1973**

- This federal law requires equally effective access to electronic & IT products and services.

**w3schools HTML Color Picker**

- This tool can assist you in picking accessible colors by showing you how the color would appear with black or white text on it as well as different shades of the color.
Accessible Attachments

Attachments can serve two purposes: provide additional information and provide information in an accessible way for people with disabilities. Whenever you attach anything to an email that is being sent to the campus, be sure that the attachment is accessible.

Standard User Resources

The following resources can assist you in creating accessible documents.

**Microsoft Office: Use the Accessibility Checker on your Windows desktop to find accessibility issues**

- This article covers how to use the Accessibility Checker in Microsoft Word, Excel, and PowerPoint to make your documents accessible.

**Microsoft: Create accessible PDFs**

- This article covers how to save a Microsoft Office document as an accessible PDF. NOTE: you may want to check these PDFs with the Adobe Acrobat accessibility checker.

**Adobe Acrobat: Create and verify PDF accessibility**

- This article covers the basics of using Adobe Acrobat Pro to make your PDF accessible.

**Professional Development for Accessible Technology: Documents & Multimedia**


**HHS Section 508 Accessibility checklists**

- Dept of Health & Human Services checklists for ensuring documents are accessible including: PDF, Word, Excel, PowerPoint, HTML file, and multimedia file. While their guidelines are slightly different from ours, these checklists are a useful way to approach making documents accessible.
Advanced User Resources

w3schools HTML Color Picker

• This tool can assist you in picking accessible colors by showing you how the color would appear with black or white text on it as well as different shades of the color.

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Requesting a Distribution List

This article covers how Department IT Coordinators (DITCs) can request a new distribution list.

⚠️ Only authorized Department IT Coordinators are eligible to request distribution lists. To find out more about becoming an authorized Department IT Coordinator, please email telecom@fullerton.edu.

What's the Difference Between a Campus Distribution List and a Distribution List?

Please view What's the Difference Between a Campus Distribution List and a Distribution List? for more information on each type of list.

1. Send an email to HelpDesk@fullerton.edu to request a new distribution list.

Send an email to HelpDesk@fullerton.edu and include the following information:

1. The name for your distribution list (e.g., DL-Technology_Coordinators).
2. The owner of the distribution list. This person's name will be listed as the owner in the Outlook Address Book and will be the main point of contact for questions about the distribution list.
3. The names of all of the people who need to be able to add/remove members from the distribution list.
4. Whether anyone should be able to send an email to the distribution list or if only select people should be able to send emails to the distribution list. If only select people should be able to send to it, list the people who should be allowed to send emails to the distribution list.
Distribution List Owners will be able to add additional co-owners who can add/remove members from the distribution list in the future. They can also add/remove people who are authorized to send emails to the distribution list.

2. Once your distribution list is ready, you will receive an email confirming it is ready to use.

Be sure to view information on:

- Sending an Email to a Distribution List
- Managing Members of Your Distribution List
- Managing Your Distribution List

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Clearing saved Distribution Lists

These instructions will guide you how to remove saved distribution lists and start using the distribution lists in Office 365

1. In your Office 2016 desktop application, construct an email and type the name of the Distribution List name you want to send to
2. Hover over the name, then click the "X" to the far right to remove the saved address

Now we'll add the new distribution list from Office 365
3. Click To..., then select the Global Address List
4. Type the Distribution List name, select it, and add it to the To... (Cc.. or Bcc...) field

5. The DL name has been added from the Global Address book

6. Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance
How to Clear the Cached Email Address from your Email Address Bar

This article covers how to clear the cache of auto populated email addresses and distributions lists (DLs) from your email address bar.

Remove the cached account from the address bar.

The process for removing an account from the email address bar cache (AutoComplete) is similar on PC and Mac.

1. From your Office 2016 desktop application, type the name of the Distribution List name you want to send to.

The DL will appear in the drop-down window. Hover over the name to highlight it, then click the "X" to the far right to delete the account.

Email // Downloaded: 06-15-2019 // Disclaimer: This document is only valid as of the day/time when it is downloaded. Please view the original web document for the current version.
2. The account will be removed from your cached list of addresses.

Repeat this process for each account you want to remove from the address bar cache.

Add Email addresses and DLs from the Global Address List

In order to send to the most recent account, a new email address and Distribution List (DL) name must be added from the Global Address List (GAL/LDAP).

You can search for a user by name or email address. You can search for a distribution list by typing in part or all of the DL name.
1. In your email, on your PC, click "To...", then select the Global Address List (GAL).

1. **Create** a new email, then click **To...** (**Cc...** or **Bcc**...).
2. Click the drop-down icon to display the search directory address lists, folders, contacts, etc.
3. Select the **Global Address List**.

**Add the Distribution List (DL) account to your email from the Global Address List (GAL).**
1.1. In the search window, type the account or distribution list name, then add the member to the To..., Cc.. or Bcc... field.

1. Type an account name, email address, or distribution list name (*i.e. dl-it-test*), then click **Go** to search for the member.
2. With the account selected, click **To**, **Cc**, or **Bcc** to add the it to your email.
3. Click **OK**.
2. In your email, on your Mac, click the address book icon.

1. Create an email, then click a address book icon to the right of the To:, Cc:, or Bcc: field.
2. Click the account directory name (or default search account).

2.1. Click the default search directory.

The search directory will display account lists, folders, contacts and directories, etc. Select the Default Global Address List (LDAP).
Some Mac OS systems will not display the Default Global Address List. Select the default campus directory for your system. The name could be the name of your account, or just Directory.

2.2. In the search window, type the account or distribution list name, then add the member to the To..., Cc.. or Bcc... field.

1. Type an account name, email address, or distribution list name.
2. Select the account.
3. Click To.., Cc.., or Bcc... to add it to your email.
4. Click the red X to close the search window.
The new email account or DL member has been added from the Global Address book.

REMEMBER: Email accounts and distribution lists will need to be removed from the address bar cache if you can no longer send and email to that account.

Need More Help?

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Find the Owner(s) of a Distribution List

This article shows you how to find out who owns and maintains a distribution list.

Find the owner(s) using Outlook 2016 (PC only)

1. Open your address book, then search for and open the distribution list.

1. Select the Address Book in your Outlook.
2. Type the distribution list name, then click Go to search for the DL.
3. When the name populates in the window, double-click the DL name.
2. View the DL owner.

DL owner(s) will be listed on the General tab in the Owner section.

Close the DL window.

Find the owner(s) using Outlook on the web

These instructions can also be used if you are using a Mac computer.

1. Log into Outlook on the web.

View the instructions on logging into Outlook on the Web.
2. Access the People icon...

from the email window

1. Click the people icon.

Click the people icon located in the bottom left corner on the page.
2. Select "Directory".

Changing the default selection from **Featured people** to **Directory** will allow you to search the entire campus directory of accounts, not just your personal list of accounts and contacts.
from the menu bar

1. Click the grid square in the top left corner.
2. Click "All Apps".

3. Search for the people icon.

1. Type **people** in the search window.
2. Click the **People** icon.
4. This will open to Directory, allowing you to search all campus accounts.


1. Type the DL name in the search window.
2. Select the DL name when it populates in the pop-up window.
Click the magnifying glass or hit **Enter** on a PC, **(Return** on a Mac) to be directed to the **Search results** window, then click the DL name in the search results window.
4. Click "Members".
5. View the owner(s) for the DL.

You will be able to view all of the owners listed in the DL.
5.1. Click on an owner of the DL to display their contact information.

![Contact Information](image)

**Need More Help?**

Contact the IT Help Desk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.
Search Outlook Items (Email) in Outlook 2013 on a PC

This article covers how to search for email items in Outlook 2013 on a PC.

**NOTE: In addition to email, you can search other Outlook items such as: attachments, calendar items, Tasks, Notes, and Contacts.**


If Outlook is open and you are logged in, continue to [Step 2].

Single click on the shortcut icon on the tool bar. Double click on the icon on the desktop.

**NOTE: If the icon is not on the desktop or on the tool bar proceed to Step 1.1.**
1.1. Locate Outlook 2013 in All Programs

![Image of Outlook 2013 located in All Programs]

**NOTE:** If you are not logged into Outlook, log into your email account with your username and password.

2. Click the Search Tab.

1. Select **Current Mailbox** from the drop-down or **Scope** in the **Search** menu.
2. Click one of the search options to begin searching your email. To select multiple folders (regular and online archive) select All Mailboxes.

3. Click All Outlook Items to search other Outlook items such as: attachments, calendar items, Tasks, Notes, and Contacts within Outlook 2013.

3. Type Your Search Criteria.

Click the magnifying glass to begin your search.

4. Your Search Results will be Displayed Below.
Need More Help?

- Move/Export Email (Outlook)
- Delete Email from Campus Mailbox (including Online Archive & PST/Local Data File Folders)
- Exchange Archiving (Outlook)

Resources for Campus Email

Created by: DBH
Search Outlook Items (Online Archive) in Outlook Web Access (OWA)

This article will show you how to search for email, attachments, calendar, Tasks, Notes, and Contacts items using Outlook Web Access in your web browser.

1. Log into Your Email.

Open your browser, go to email.fullerton.edu.

Click on **Faculty / Staff Login**. Log into Outlook with your CSUF email username and password.

** Or on your Mac, open your Outlook email desktop application.
2. Search Online Archive Mailbox.

1. Select **Personal Archive** mailbox.
2. Click the drop-down arrow.
3. Select ** Entire Personal Archive**.
4. Enter your search criteria.

**NOTE:** There is no way to search both your regular and online archive mailboxes at the same time in Outlook on the web. Select your personal mailbox (i.e. *Lane, Lana*) to search the active mailbox.

**Need More Help?**

[Resources for Campus Email](#)

Created by: DBH
Contact Help & Resources to Search and Maintain Campus Email

This article covers help and resource information to search and maintain your faculty/staff campus email.

Contact Help Information

Contact the IT Helpdesk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.

Resource Information

• Search Outlook Items (Email) in Outlook 2013 on a PC
• Search Outlook Items (Email) in Outlook 2016 on a Mac
• Search Outlook Items (Email) in Outlook Web Access (OWA)

Email Usage and Maintenance

Created by: DBH
Exchange Archiving
(Outlook)
Access Online Archive Email from a PC or Mac

This article will show you how to access your Outlook archive email in Outlook 2016 on a PC or Mac.

All emails, calendar items, and tasks that are older than one year will be moved to your **Online Archive** folder.

Once emails have been moved to your online archive folder, you will no longer be able to find them in your live email account. You will need to look in your online archive email account for your archived emails.

**NOTE**: Access to your Online Archive emails are similar for both PC and Mac.

1. Open your Outlook app on your desktop computer.

Click the Outlook icon to log into your email.
2. In the folder pane of your email, find and expand your Online Archive folder.

3. You can now explore your Online Archive folders.
All of your folders within **Online Archive** will contain emails older than one year, if you have any.

---

**Need More Help?**

Contact the IT Helpdesk at [helpdesk@fullerton.edu](mailto:helpdesk@fullerton.edu) or 657-278-7777.

- [Email and Online Archive Resources](#)

Created by: DBH
Access Online Archive Email from a Web Browser

This article will show you how to access your Outlook archive email from a web browser.

- All emails, calendar items, and tasks that are older than one year will be moved to your online archive folder, **Personal Archive**.

**WARNING** Once emails have been moved to your online archive folder, you will no longer be able to find them in your live email account. You will need to look in your online archive email account for your archived emails.

1. Log into your email on the Web.

   [View instructions on logging in to Outlook on the web](#)
2. In the folder pane of your email, find and expand your Personal Archive folder.

In your web access, the online archive folder is called **Personal Archive**, in your desktop application it is called **Online Archive**. Your archived data will be the same in both locations and folders.
The ability to expand your online archive folder may not be seem when you initially log into your online email account. Click your **Personal Archive** folder to display the expand option.

3. You can now explore your online archive folders in Personal Archive.

![Personal Archive - Lane, Lana](image)
- Archive
- Conversation History
- Deleted Items: 23
- Sent Items
- Inbox: 42

**All of your folders within Personal Archive will contain emails older than one year, if you have any.**

**Need More Help?**

Contact the IT Helpdesk at [helpdesk@fullerton.edu](mailto:helpdesk@fullerton.edu) or 657-278-7777.

[Email and Online Archive Resources](#)
Contact Help & Resources for Email and Online Archive

This article covers help and resource information when using the Online Archive email account.

Contact Help Information

Contact the IT Helpdesk at helpdesk@fullerton.edu or 657-278-7777 for additional assistance.

On Campus Resource Information

Email and Online Archive

- Access Online Archive Email from PC or Mac
- Access Online Archive Email from a Web Browser
- Search Outlook Items (Email) in Outlook 2013 on a PC
- Search Outlook Items (Email) in Outlook 2016 on a Mac
- Search Outlook Items (Email) in Outlook Web Access (OWA)

Email Usage and Maintenance

Terms and Definitions

Adding an Additional Exchange Account verses Additional Exchange Mailbox.

Add an Additional Exchange Account:

- Requires you to log in with the account which holds that email address, (username and password) for the initial setup
• You will be granted “Full Access” permissions to the mailbox, and can log on with your own credentials

Add/ Manage an Additional Exchange Mailbox when:

• You have not been granted “Full Access” permissions to the mailbox by your Exchange administrator
• You've been granted “Folder-level” or “Delegate” permissions by the mailbox owner
• You can add the mailbox to your Outlook configuration without password

⚠️ If you can't expand the mailbox, you haven't been granted the correct permissions by the mailbox owner.

More information on adding a second (addition exchange account) and adding an additional (Exchange) mailbox.

• https://www.msoutlook.info/question/841

Delegate Access verses Folder Sharing

Delegate Access:

• Allows you to give someone permission to act on your behalf
• A user can create and respond to meeting requests for you, if permission has been given
• A user can monitor your Inbox and send email on your behalf, if permission has been given
More about what a Delegate can do: https://support.office.com/en-us/article/allow-someone-else-to-manage-your-mail-and-calendar-41c40c04-3bd1-4d22-963a-28eafec25926

Folder Sharing:

• Lets other people access one or more folders
• Does not include permissions for others to act on your behalf
• Doesn't allow others to reply to email messages or respond to meeting requests for you

For more information on Delegate Access and Folder Sharing


Delete verses Purge Emails

Purged Emails

• Purged from the Recoverable Items folder can't be recovered

Understanding Shared Mailboxes in Office 365

• Shared mailbox is a mailbox that multiple users can use to read and send email messages
• Shared mailboxes make it easy for a specific group of people to monitor and send email from a common account, like public email addresses
• shared mailbox doesn't have its own user name and password
• You can't log into a shared mailbox directly using Outlook, Outlook Web App, Exchange ActiveSync, Exchange Web Services (EWS), or any other Exchange protocol
• You must first be granted permissions to the shared mailbox,
• Shared mailboxes don't have an assign licenses, therefore the storage quota of the mailbox is 50 gigabytes (GB)
• If you go over its quota of 50GB, after one month the shared mailbox will be locked.

More information Understanding Shared Mailboxes

Created by: DBH
Delete Email from Campus Mailbox (including Online Archive & PST/Local Data File Folders)
Delete Individual Messages

This article covers how to delete individual email messages using Microsoft Outlook desktop application.

**NOTE:** In addition to deleting email from your regular email you will also be able to delete email from the Online Archive or local data file folders.

** The same instructions apply for a PC, as well as Mac desktop workstation.

1. Find the Email to Delete.

(1) Click to select the email; or (2) hover over the email you want to delete.
(3) Hover to the far right of the email to expose the delete icon on the email, then click the X.

1.1. To Permanently Delete Email.

Hold the SHIFT key on the keyboard while deleting the email.
Click Yes to continue.
NOTE: Email is moved directly to the permanently deleted folder. You will not be able to recover it from the regular Deleted Items folder. To recover permanently deleted email view Recover Deleted Email Items.

2. Deleted Email is Moved to the Deleted Items Folder.

Need More Help?
Resources for Campus Email
Created by: DBH
Delete Multiple Messages

This article covers how to delete multiple email messages using Microsoft Outlook desktop application.

**NOTE:** In addition to deleting email from your regular email you will also be able to delete email from the Online Archive or local data file folders.

** The same instructions apply for a PC, as well as a Mac desktop workstation.

Select Multiple Email to Delete

If you know the email you want to delete you can select the emails; otherwise review Searching Email to find the email you want to delete.

1. Select Email Randomly.
Hold the CTRL key as you select (or deselect) the desired email as you go through your email. When the emails you want to move are selected they will be highlighted.

2. Select Email in a Continuous Row.

Click to select the first email. Use the scroll bar, if needed, to go to the last email. Hold the SHIFT key and click the last email to be deleted. All selected email will be highlighted.

Delete Email

3. Click Delete Icon on Home Ribbon.
4. Right-click on a Highlighted Email.

On the pop-up, click **Delete**.

**Permanently Delete Email**

5. Hold SHIFT Key on Keyboard While Deleting Email.

Click **Yes** to continue.
NOTE: Email is moved directly to the permanently deleted folder. You will not be able to recover it from the regular Deleted Items folder. To recover permanently deleted email view Recover Deleted Email Items.

Deleted Email

6. Deleted Email is Moved to the Deleted Items Folder.

Need More Help?

Resources for Campus Email

Created by: DBH